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LESSON 1 -  
DESIGNING ADVANCED QUERIES  

In this lesson, you will learn how to: 

• Set top values in a query  

• Create a calculated field  

• Format a calculated field  

• Create a function query  

• Create a parameter query  

• Create a concatenation in a query  

• Filter a query  

 



Lesson 1 - Designing Advanced Queries Access 2002 - Level 3 

SETTING TOP VALUES IN A QUERY 

 Discussion 
You can limit the results of a query so that only the highest or lowest values in a field 
appear in the recordset. For example, you can set the top values of a Quantity Sold 
field to 10 to find the top ten best-selling products. 
 
You can also limit the number of records to a specific number or percentage of all 
records being queried (i.e. the top 25%). The field for which you are setting the top or 
bottom values must be sorted. If the field is sorted in descending order (Z to A, 9 to 
0), the top values will be found. If the field is sorted in ascending order (A to Z, 0 to 
9), the bottom values will be found. 

 
Setting top values in a query 

 
  

 
If other fields in the query are sorted, they must appear to the 
right of the field for which you are finding top or bottom 
values in the design grid. 

  

 
You can also type a value into the Top Values box on the 
Query Design toolbar. 
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 Procedures 

1. Open the desired query in Design view. 

2. Select the Sort row of the desired field. 

3. Select the Sort list. 

4. Select the desired sort order. 

5. Select the Top Values list on the Query Design toolbar. 

6. Select the desired option. 

 

SETTING QUERY PROPERTIES 
Each query has property settings that you can change to alter the way the query behaves and how 
the query results look. 
 

 
 
To display the Query Properties dialog box shown above, you can do one of the following: 

• Select View … Properties from the menu bar in the Query window 
• Point at the top half of the query window and select Properties from the shortcut menu 
• Click in the top half of the query window and click on the Properties button on the toolbar 
• Double-click in the top half of the query window 
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You can also set properties for the individual fields in the query.  Slightly different options are 
available for fields.  To see the Properties dialog box for a field, click in the field you want and 
use the shortcut menu. 
 

 Description 
This works best with fields, rather than the general query.  In the Description property, type the 
description you want the status bar to display for that field in the query's results. Users will see 
the new description in the status bar when they click in the field in query Datasheet view. 
 

 Output All Fields 
Use to show all fields in the query's underlying data. This is an easy way to show all fields in the 
query while only moving those you are setting criteria for or sorting on down to the query grid. 
 
Yes Displays all the fields in the underlying tables and in the field list of a form or report. 
No (Default) Displays only fields having the Show box selected in the query design grid. 

 
 Top Values 

Use to return a specified number of records or percentage of records that meet the criteria 
specified. For example, you might want to return the bottom 5 values or the top 10% of values in 
a field. 
 
Use together with sorted fields. The field you want to display top values for should be the 
leftmost field that has the Sort box clicked in the query design grid. An Ascending sort returns the 
bottommost records, and a Descending sort returns the topmost records. If you specify that a 
specific number of records be returned, all records with values that match the value in the last 
record are also returned. 
 

 Unique Values 
Use when you want to omit records that contain duplicate data in the fields displayed in Datasheet 
view. For example, if a query's output includes more than one field, the combination of values 
from all fields must be unique for a given record to be included in the results.  This property 
uses all the fields which have been moved to the query grid. 
 
Yes Displays only the records in which the values of all fields displayed in Datasheet 

view are unique. 
No (Default) Displays all records. 
 

 Unique Records 
Use to specify whether to return only unique records based on all fields in the underlying data 
source, not just those fields present in the query itself. 
 
Yes (Default) Doesn't return duplicate records. 
No Returns duplicate records 

 
 Run Permissions 

Used in a multi-user environment with a secure workgroup to override the existing user 
permissions.  
 
Owner's All users are allowed the owner's permissions to view or run the query. 
User's (Default) Users have only their own permissions to view or run the query. 
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 Records Locks 
Use to set what happens when two users try to edit the same record at the same time. When you 
edit a record, Microsoft Access can automatically lock that record to prevent other users from 
changing it before you are finished. You can use this property to specify whether records in a 
query (typically an action query in a multi-user database) are locked while the query is run. 
 
No Locks (Default) In queries, records aren't locked while the query is run. 

All Records All records in the underlying table or query are locked while the query is 
run. Although users can read the records, no one can edit, add, or delete 
any records until the query has finished running. 

Edited Record 
(Forms and queries 
only) 

A page of records is locked as soon as any user starts editing any field in 
the record and stays locked until the user moves to another record. 
Consequently, a record can be edited by only one person at a time. This is 
also called "pessimistic" locking. 

 

SET PROPERTIES FOR A QUERY, ITS FIELDS, OR ITS 
FIELD LISTS 
You can set properties for queries, field lists in a query, and fields you add to the design grid in a 
query. 
 
1. In query Design view, select the field, field list, or query. 

 To select a field, click the cell in the Field row. 
 To select a field list, click anywhere in the list. 
 To select the whole query, click anywhere in query Design view outside the design 

grid and the field lists. 
2. Click on the toolbar to display the property sheet for the selected object. 
3. In the property sheet, click the property you want to set, and then do one of the following: 

 If an arrow appears in the property box, click the arrow and then click a value from 
the list. 

 Type a setting or expression in the property box. 
4. If a Build button appears next to the property box, click it to display a builder. 
5. If you need more space to enter or edit a property setting, press SHIFT+F2 to open the Zoom 

box. 
 
Tip: When you click a property in the property sheet, a short description of the property 

appears in the status bar. For more information on the property and its settings, click the 
property and then press F1. 
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CREATING A CALCULATED FIELD 

 Discussion 
Access allows you to create expressions that calculate new field values; for example, 
you can create an expression that multiplies the value in the Quantity field by the 
value in the Price field to calculate total sales. You can also create an expression that 
adjusts a value in a single field, such as doubling a Wholesale Price field to calculate 
values for a Retail Price field.  
 
In expressions, field names are enclosed in square brackets ([ ]); numbers are not. For 
example, to calculate 20% of sales and display the results in a column named 
Commission, you would enter Commission:.2*[Sales] in the design grid. (The colon 
separates the column name from the expression.) 
 
Calculated fields are created in queries. You can also use criteria to remove 
nonessential records, thereby allowing the query to run faster. The results of your 
query can then be used to generate a report. 

 
Creating a calculated field 

 
  

 
The field names used in an expression must be the same as the 
field names that appear in the table. 

  

 
You can also use the Expression Builder to create a calculated 
field by selecting any blank Field row and clicking the Build 
button on the Query Design toolbar. 
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 Procedures 

1. Open the desired query in Design view. 

2. Select any blank Field row. 

3. Type the desired field name and a colon (:). 

4. Type the expression required to perform the calculation. 

5. Press [Enter]. 

 

FORMATTING A CALCULATED FIELD 

 Discussion 
Once you have created a calculated field, you can change its properties as you would 
any other field on the design grid. The Format property determines how data appears 
in Datasheet view. For example, you can change the properties of a calculated field 
so that the field values display as currency. 
 

  

 
You can also change the format of a calculated field by right-
clicking anywhere in it and selecting the Properties 
command. 

  
 

 Procedures 

1. Open the desired query in Design view. 

2. Select the Field row for the calculated field you want to format. 

3. Select the Properties button  on the Query Design toolbar. 

4. Select the General page in the Field Properties box. 

5. Select the Format box. 

6. Select the Format list. 

7. Select the desired format. 
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CREATING A FUNCTION QUERY 

 Discussion 
Access allows you to create a query that groups records by a selected field and then 
applies a function that calculates a value within the grouped fields. For example, you 
could group records by state and then select the Count function to find out how many 
customers (records) are in each state (field), or you could group records by customer 
name and then calculate the Sum of each customer’s orders. 
 
Access allows you to perform more than one calculation on a field. For example, you 
can group records by weekly sales and then find both the minimum and maximum 
values. 
 
There are several types of functions from which you can choose. The most commonly 
used functions are listed in the following table: 

 
Function Description 
Sum Totals the values in the calculated field 
Average Averages the values in the calculated field 
Count Counts the number of records in the calculated field 
Max Finds the highest value in the calculated field 
Min Finds the lowest value in the calculated field 

 
 

  

 
To perform more than one calculation on a field, you must add 
the field to the design grid a second time and create the 
desired expression. 

  

 
You can also add a Total row by right-clicking in the design 
grid and then selecting the Totals command. 

  
 

 Procedures 

1. Open the desired query in Design view. 

2. Select the View menu. 

3. Select the Totals command. 

4. Select the Total row in the field you want to calculate. 

Page 8 Organizational & Staff Development, U of T
 



Access 2002 - Level 3 Lesson 1 - Designing Advanced Queries 

5. Select the Total list. 

6. Select the desired function. 

 

CREATING A PARAMETER QUERY 

 Discussion 
You can create a query to which you add different criteria each time you run it; such a 
query is called a parameter query. A parameter query is designed to prompt the user 
for input each time it is run; Access then runs the query based on the criterion 
(parameter) entered. A parameter query allows you to quickly and easily change query 
criteria without having to redesign the query. 

 
Creating a parameter query 

 
  

 
You can add multiple parameters to a query; when you run the 
query, a prompt will appear for each parameter in it. 

  
 

 Procedures 

1. Open the desired query in Design view. 

2. Select the Criteria row in the desired field. 

3. Type an open bracket ([), the desired prompt, a colon, and the close 
bracket (]). 

4. Press [Enter]. 
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CREATING A CONCATENATION IN A QUERY 

 Discussion 
A concatenation query allows you to combine two or more text fields into one field. In 
other words, concatenation enables you to append one text string to another. In 
addition, you can insert characters between the text strings as needed. For example, 
you can concatenate the City, State, and Postal Code fields and store the 
concatenated text string in a fourth field, the Address field, adding commas and 
spaces between the text strings as needed. 
 
When typing a concatenation expression, the first part of the expression defines the 
name of the new field and the second part of the expression defines the fields which 
are to be concatenated. All field names must be surrounded by brackets. The 
concatenation character (the ampersand - &) appears between field names, and you 
must enclose any additional characters in double quotes. For example, the expression 
Names: [Last Name]&", "&[First Name] concatenates the Last Name and First 
Name fields and inserts the concatenated text string into a field called Names. The 
new field displays the last name, a comma, a space, and the first name for each record 
in the table. 

 
Creating a concatenation expression 

 
  

 
You can also use concatenation to create text strings in forms 
and reports. 

  

 
To use the Expression Builder to concatenate text, select any 
blank Field row and click the Build button on the Query 
Design toolbar. 
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 Procedures 

1. Open the desired query in Design view. 

2. Select any blank Field row in the design grid. 

3. Type the desired concatenation expression. 

4. Press [Enter]. 

 

JOIN TYPES IN A QUERY 
When you add more than one table or query to a query, you need to make sure their field 
lists are joined to each other with a join line so that Microsoft Access knows how to 
connect the information.   An association between a field in one table or query and a field 
of the same data type in another table or query is defined as a JOIN.  A join tells 
Microsoft Access how data in each of the tables or queries is related to the other tables or 
queries. 

If you previously created relationships between tables in the Relationships window, 
Access automatically displays join lines when you add related tables in query Design 
view. If referential integrity is enforced, Access also displays a "1" above the join line to 
show which table is on the "one" side of a one-to-many relationship and an infinity 
symbol (∞) to show which table is on the "many" side. 

If relationships were not previously defined and if one of the fields is a primary key, 
Access automatically creates a join between fields with the same names and data types.  
The chances are good that this will be the correct join but you should always check.  
There will not be a “1” or infinity sign displayed when this happens. 

If the tables you add to the query don't include any fields that can be joined, you will 
need to add one or more extra tables or queries to serve as a link between the tables with 
the data you need.  For example, with the Graduate Student database, you would need to 
add the Student_Faculty table to be able to select a list of graduate student names with 
their supervisor names. 
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If you add tables to a query and there no join lines appear, the resulting dataset will 
include every permutation of records between the two tables as Access doesn't know 
which records in the first table are associated with which records in the second table. If 
one table had 50 records in it and the other had 10, the query's results will contain 50x10  
or 500 records. These queries usually take a long time to run and do not produce 
meaningful results. 
You can also create joins manually.  There are three Join Types to choose from. 
 
 
Join Type Description 
Inner Join 
(Default) 
 
 
 

A join in which records from two tables are combined and added to a 
dataset only if the values of the joined fields match and meet any 
conditions specified. 
 
Example:  When looking for student addresses, the only records which 
would be displayed would be records where there was a matching 
student number in the both tables.  You would not see students who did 
not take courses, nor would you see courses for which there was no 
current student. 
 

 
 
If there are records in the Master table for which there are no detail 
records OR if there are records in the Detail table for which there is no 
record in the Master table, those records will not appear in the resulting 
dataset. 
 

Outer Join With an outer join, Access retrieves records from one of the tables 
whether a matching record is found in the other table or not. 
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Left Outer Join 

 
 

 

A left outer join includes all of the records from the first (left) of two 
tables, even if there are no matching values for records in the second 
(right) table. A left outer join is indicated by a join line arrow pointing 
from left to right. 
 
Example: When looking for addresses, all records would be displayed 
from the Student table (on the left) whether or not there was a matching 
record in the Student Addr table (on the right). You would not see 
courses for which there was no current student. 
 

 
 
Records from the table on the right will only be included if there is a 
match in the joined field.  Therefore, there may be some records in the 
table on the right which are not displayed. 
 

Right Outer Join 
 

 
    

A right outer join includes all of the records from the second (right) of 
two tables, even if there are no matching values for records in the first 
(left) table. A right outer join is indicated by a join line arrow pointing 
from right to left. 
 
Example: When looking for addresses, all records would be displayed 
from the Student Addr table (on the right) whether or not there was a 
matching records in the Student table (on the left). You would not see 
students for which there was no matching student number in the Student 
Addr table. 
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Records from the table on the left will only be included if there is a 
match in the joined field.  Therefore, there may be some records in the 
Student table which are not displayed. 
 

 

DEFINE JOIN TYPES 
 
Defining the join type for a relationship in the Relationships window doesn't affect the 
relationship itself; it sets the kind of join that will be used by default when creating queries based 
on the related tables. You can always override the default join type later when defining a query. 
By default, Microsoft Access creates an inner join between related tables. 
 
1. Create the relational joins that you need between the tables by dragging the common field or 

fields from one table to another. Just as when you define relationships, you are connecting the 
primary key of one table (the field(s) shown in bold in the Table Lists) to a field of another 
table in the query.    

 
If the join lines are overlapping or crossing tables, you should just reposition the tables by 
dragging them to a better location in the window. 

 
2. In the Query-By-Example screen, double-click on the line joining the field lists of the tables 

in the query. 
 
3. Click the desired join type. 

Option 1 defines an inner join. This is the default. 
Option 2 defines a left outer join. 
Option 3 defines a right outer join. 
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4. Click on OK. 
 

DELETING JOINS AND TABLES 
If Access adds a join which you don’t want, you can delete the join.   
 
1. Click on the join line to select it – the line will appear bolded. 
 
2. Press Delete.    
 
Once the join is removed, you can remove the tables from the QBE grid as well.  Click anywhere 
in the table’s Field List and press Delete. 
 
 
 

FILTERING A QUERY 

 Discussion 
You can filter a query in the same way you filter a table or form. Since the data you 
want to filter sometimes appears in two or more tables, you might need to create a 
multiple table query. Once the query has been created, you can apply a filter to 
temporarily isolate the records you want to view. 
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The Filter By Selection feature allows you to quickly and easily filter a query to 
display only those records in which the selected value appears. Conversely, the Filter 
Excluding Selection feature filters out the selected value, leaving only those records 
that do not contain the selected value. 
 
The Filter By Form feature allows you to create more complex filters by filtering on 
multiple values and/or by creating filter expressions. In the Filter by Form window, 
for example, you can create And and Or filters, use wildcards, and filter by ranges. 
 

  

 
To filter a query, you can also right-click the field on which 
you want to filter and then either select the Filter Excluding 
Selection command or type the desired filter into the Filter 
For box. 

  
 

 Procedures 

1. Open the desired query in Datasheet view. 

2. Select the value by which you want to filter. 

3. Click the desired filter button on the Query Datasheet toolbar. 

4. Enter the desired filter(s) in the Filter By Form window, if 
applicable. 

5. Click the Apply filter button  in the Filter By Form window, if 
applicable. 
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LESSON 2 -  
USING ACCESS DATA IN WORD AND EXCEL  

In this lesson, you will learn how to: 

• Use Access Data in a Word Merge 

• Use Access Data to Create a Worksheet 

• Use Access Data to Create a Workbook 

 

USING ACCESS DATA IN A WORD MERGE 

Discussion 
If you have your names and addresses stored in an Access table, it is possible to use 
them to generate a form letter in Word.  
 
Alternatively, you can use the Merge It with Microsoft Word button on the toolbar.  
 

Procedures 

1. Open the desired Access database. 

2. Click on the table or query you want to use in your merge letter. 

3. Select Tools. 

4. Select Office Links. 

5. Select Merge it with Microsoft Word. 

6. Select from the options – use an existing Word document or create a new one. 

7. Select the desired Document Type.  For our purposes here, select Form Letters. 

8. Click on Next: Starting Document. 

9. Select the Starting Document option: Use the Current Document 

10. Click on Next: Select Recipients to confirm the data source. 
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11. Click Next: Write your letter. 

12. If you have not already done so, in the main document, type the text that you want to 
appear in every form letter.  

13. Use one of the following methods to insert merge fields where you want to merge names, 
addresses, and other data from the data source. 

Address Block with Name, 
Address, and Other Information 
a. Click Address block.  

b. In the Insert Address Block dialog box, 
select the address elements you want to 
include and the formats you want. 

c. Click OK.  
d. If the Match Fields dialog box appears, 

Microsoft Word may have been unable 
to find some of the information it needs 
for the address block.  

Click the arrow next to (not available), 
and then select the field from your data 
source that corresponds to the field required for the mail merge.  

Greeting Line 
a. Click Greeting line.  
b. Select the greeting line format, which includes the salutation, name format, 

and following punctuation.  

 
c. Select the text you want to appear in cases where Microsoft Word can't 

interpret the recipient name, for example, when the data source contains no 
first or last name for a recipient, but only a company name.  

d. Click OK.  
e. If the Match Fields dialog box appears, Microsoft Word may have been 

unable to find some of the information it needs for the address block.  
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Click the arrow next to (not available), and then select the field from your 
data source that corresponds to the field required for the mail merge.  

Other Fields of Information 

a. Click More items.  
b. Do one of the following:  

• To select from address fields that will automatically map to 
corresponding fields in your data source, even if the data source's fields 
don't have the same name as your fields, click Address Fields.  

• To select from fields that always take data directly from a column in a 
database, click Database Fields.  

• In the Fields box, click the field you want.   

• Click Insert 

• Click Close.  
c. If the Match Fields dialog box appears, Microsoft Word may have been 

unable to find some of the information it needs for the address block.  

Click the arrow next to (not available), and then select the field from your 
data source that corresponds to the field required for the mail merge.  

14. Format the letter in the fashion you would like. To format any of the merged fields, you 
must format in the main document. Formatting in the data source is not retained when 
you merge the data into the document.  

 
• Be sure that you include the surrounding merge field characters («« »») when you 

select the field you want to format. 
 
15. After you've completed the main document and inserted all of the merge fields, save the 

document.  

16. When you have entered all the merge fields, click on Next: Preview Your Letters. 

17. Check that the fields have been properly place.  If you need to make any changes, return 
to the previous step. 

18. To preview the items in order, click the arrow buttons.     

19. To locate and preview a specific 
item, click Find a recipient, and 
then enter the search criteria in the 
Find Entry dialog box.  
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20. If necessary, fine-tune the recipient list.  

 
• To exclude a particular recipient from the merge, click Exclude this 

recipient while looking at the recipient’s letter. 
• To change the list of recipients, click Edit recipient list, and then make your 

changes in the Mail Merge Recipients dialog box.  
 
21. Click on Next: Complete the Merge. 

22. Complete the merge by selecting one of the following: 

Personalize Individual Letters 
To personalize individual documents, you actually complete the merge, and then edit the 
information you want in the resulting merged document. 

a. Click Edit individual letters.  
b. In the Merge to New Document dialog box, select the records you want to 

merge. 
c. Click OK. 

Microsoft Word creates and opens a new merged document. Your main 
document also remains open, and you can switch back to it if you want to 
make a change to all the documents.  

d. Scroll to the information you want to edit, and make your changes. 
e. Print or save the document just as you would any regular document. 

Print the Letters 
Do one of the following: 
If you personalized the items and the merged document is active 

1. Select File … Print.  
2. Select the options you want. 
3. Click on OK. 

If you want to print directly from the Mail Merge Wizard 
1. Click Print.  
2. In the Merge to Printer dialog box, select one of the following: 

 Click All to print all the documents. 
 Click Current record to print the document that you see in the 

document window.  
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 Click From, and type in the record numbers in the From and To 
boxes to print a range of documents. 

3. Click on OK. 
4. In the Print dialog box, select the options you want.  

Save the Merged Letters for Later Use 
If you want to edit merged letters or save them for later use, you can collect them 
into a single document. 
1. Click Edit individual letters.  
2. In the Merge to a New Document dialog box, do one of the following,  

 Click All to print all the documents. 
 Click Current record to print the document that you see in the 

document window.  
 Click From, and type in the record numbers in the From and To 

boxes to print a range of documents. 
3. Click on OK. 
 
Microsoft Word opens a single new document that contains all the individual 
letters. You can then save the document for later use, just as you would any 
regular document.  

 
 

USING ACCESS DATA TO CREATE A WORKSHEET 

Discussion 
You may want to create a worksheet in an existing Excel workbook using Access 
data. You can easily send a table or query from the source file in Access to the 
destination file in Excel. The exported data appears automatically on the last 
worksheet in the workbook and the tab reflects the name of the Access table and 
query. Once the data is exported to Excel, it becomes part of the destination file and 
can only be edited using Excel features.  
 
When you export Access data to Excel, the destination file to which you are exporting 
needs to be closed or you cannot export the data. Once the data is exported, you can 
open the destination file in Excel to view and edit the Access information. 

Procedures 

1. Close the Excel file to which you want to send the Access data. 

2. Open Access. 

3. Open the Access database containing the desired data. 
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4. Select the Tables or Queries tab. 

5. Click on the desired table or query. 

6. Select the File menu. 

7. Select the Export command. 

8. Select the Save as type list and change to Microsoft Excel 97-2002 
(*.xls). 

9. Locate the desired Excel file to which you want to send the table or 
query.  

10. Click on Export. 

 

USING ACCESS DATA TO CREATE A WORKBOOK 

Discussion 
You may have Access data you want to use to create a new Excel workbook. Rather 
than copy and paste the information, you can send it to Excel to create a new 
workbook. Once the data is sent to Excel, you can edit it using features of the source 
application, just as you would edit a workbook created in Excel. 

 
   

• You can also access the Analyze It with MS Excel command 
from the OfficeLinks submenu on the Tools menu. 

 

   

Procedures 

1. Open the desired Access database. 

2. Select the Table or Queries tab.  

3. Select the desired data. 

4. Click the arrow on the OfficeLinks button.   

5. Select the Analyze It with MS Excel command. 
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LESSON 3 -  
CREATING BASIC REPORTS  

In this lesson, you will learn how to: 

• Use reports  

• Use the Report Wizard  

• Use print preview - reports  

• Print pages of a report  

• Group and summarize report data  

• Base a report on a query  

• Use AutoReport  
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USING REPORTS 

 Discussion 
Although you can print records from a table or form, a report provides more precise 
control over the final output. Reports can include page headers and footers, calculated 
totals and subtotals, and even graphics. In addition, reports can be used for invoices, 
orders, presentations, and mailing labels. 
 
There are two basic types of reports: columnar and tabular. In a columnar report, the 
field names are listed on the left side of the page, and the field values are listed on the 
right. If space on the page permits, there can be more than one column. In a tabular 
report, the field names are listed across the top of the report, and the field values 
appear in the corresponding columns. 
 
Reports can include data from a single table or related tables. Reports can also be 
based on queries. 
 

  

 
You cannot edit data in a report. 

  
 

USING THE REPORT WIZARD 

 Discussion 
You can use the Report Wizard to quickly and easily create a report. The basic steps 
needed to create a report using the Report Wizard are as follows: 

 
1. Select the table(s) you want to use. 

2. Select the fields you want to include. 

3. Group the data. 

4. Add grouping levels. 

5. Sort the data. 

6. Select a layout. 

7. Select a style. 

8. Name the report. 
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When you have finished creating a report, the Report Wizard displays it in print 
preview. Print preview allows you to view the report before you print it. 

 
Using the Report Wizard 

 
  

 
If you base a report on only one table, the Report Wizard does 
not ask you to specify a table on which to group the data. 

  

 
If you include fields from unrelated tables in the report, 
Access closes the Report Wizard and opens the Relationships 
window so that you can create the necessary relationship. 

  

 
You can also activate the Report Wizard by double-clicking 
the Create report by using wizard option in the Reports 
object list in the Database window, by selecting the Insert 
menu and the Report command, or by clicking the New 
Object button on the Database toolbar and selecting the 
Report command. 

  
 

 Procedures 

1. Display the Reports object list. 

2. Select the  New button on the Database window toolbar. 
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3. Select Report Wizard. 

4. Select OK. 

5. Select the Tables/Queries list. 

6. Select the table or query on which you want to base the report. 

7. Add the desired fields to the Selected Fields list box. 

8. To add another table to the report, select the Tables/Queries list. 

9. Select the desired table or query. 

10. Add the desired fields to the Selected Fields list box. 

11. Select Next >. 

12. Select the desired option in the How do you want to view your 
data? list box. 

13. Select Next >. 

14. Select the desired grouping level in the Do you want to add any 
grouping levels? list box. 

15. Select Next >. 

16. To sort the records, select the 1 list. 

17. Select the field by which you want to sort. 

18. Select Next >. 

19. Select the desired report layout. 

20. Select the desired report orientation. 

21. Select Next >. 

22. Select the desired report style. 

23. Select Next >. 

24. Type the desired report name. 

25. Select Finish. 

 

USING PRINT PREVIEW - REPORTS 

 Discussion 
When you open a report, it appears in print preview. Print preview allows you to see 
how the printed report will look before you print it. 
 

Page 26 Organizational & Staff Development, U of T
 



Access 2002 - Level 3 Lesson 2 - Creating Basic Reports 

Print preview provides options for viewing the report. By default, the report appears 
magnified at 100%, the same size as the printout. You can zoom out to see more of the 
report or zoom in to see a portion of the report in more detail. The Zoom list in print 
preview allows you to choose from several magnification options, from as small as 
10% to as large as 500% or 1000%. 
 
You can display a report in One Page, Two Pages, or Multiple Pages view. The 
buttons at the bottom of the window allow you to navigate pages, and the scroll bars 
allow you to view different areas of a page. 

 
Using print preview 

 
  

 
You can also access print preview by right-clicking a report in 
the Database window and selecting the Print Preview 
command. 

  

 
You can also use the Zoom list on the Print Preview toolbar 
to switch the magnification between 100% and to fit the 
window. 

  
 

 Procedures 

1. Display the Reports object list. 

2. Select the report you want to preview. 

3. Select the  Preview button on the Database window toolbar. 
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4. Click the area of the report page you want to magnify to 100%. 

5. Click anywhere in the report page to change the magnification back 
to fit the window. 

6. Click the Two Pages button  on the Print Preview toolbar to 
display two pages of the report. 

7. Click the One Page button  on the Print Preview toolbar to 
display one page of the report. 

8. Click the Next Page button  at the bottom of the report window 
to display the next page of the report. 

9. Click the Last Page button  at the bottom of the report window 
to display the last page of the report. 

10. Click the Previous Page button  at the bottom of the report 
window to display the previous page of the report. 

11. Click the First Page button  at the bottom of the report window 
to display the first page of the report. 

 

PRINTING PAGES OF A REPORT 

 Discussion 
You can print specific pages of a report. This option is useful if the report contains 
numerous pages, and you only need information from one or more particular pages. 
The Print dialog box allows you to specify the pages you want to print. 
 

  

 
You can print a report from the Database window or from 
print preview. 

  

 
To print an entire report, select it and click the Print button on 
the Database toolbar. 

  

 
You can also open the Print dialog box by right-clicking the 
report you want to print and selecting the Print command. 

  
 

Page 28 Organizational & Staff Development, U of T
 



Access 2002 - Level 3 Lesson 2 - Creating Basic Reports 

 Procedures 

1. Display the Reports object list. 

2. Select the report you want to print. 

3. Select the File menu. 

4. Select the Print command. 

5. Select the Pages option. 

6. Type the number of the first page you want to print. 

7. Select the To box. 

8. Type the number of the last page you want to print. 

9. Select OK. 

 

GROUPING AND SUMMARIZING REPORT DATA 

 Discussion 
The Report Wizard provides options for grouping and summarizing report data. You 
can organize your report by selecting the fields into which you want to group data. If 
you create more than one group, you can prioritize the groups into levels. 
 
In addition to grouping data by a field, you can add grouping intervals. Grouping 
intervals vary, depending upon the selected field. For instance, a date field can be 
grouped by month, quarter, year, etc.; a numeric field can be grouped by numeric 
intervals of 10s, 50s, 100s, etc.; and a text field can be grouped by its first letter, 
second letter, etc. 
 
If you have included a field with numeric data in your report, you can add summary 
calculations. Summary calculations include Sum, Avg (average), Min (minimum), 
and Max (maximum). If you select the Sum calculation, you can include a calculated 
percentage of the total for each group. You can also display just the summary 
calculations in the report or both the field data (details) and the summary calculations. 
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Adding a grouping interval 

 
  

 
If you are grouping on multiple fields, you can use the up and 
down Priority buttons to change the order of the groups in the 
Report Wizard. 

  

 
You can add a new field to a specific location in a report by 
first selecting the field in the Selected Fields list box below 
which you want to insert the new field. 

  

 
You must use Design view to add grouping levels and 
summaries to an existing report. 

  
 

 Procedures 

1. Display the Reports object list. 

2. Select the  New button on the Database window toolbar. 

3. Select Report Wizard. 

4. Select OK. 

5. Select the Tables/Queries list. 

6. Select the table or query on which you want to base the report. 

7. Add the fields you want to include in the report to the Selected 
Fields list box. 
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8. Select Next >. 

9. Select the desired grouping option from the How do you want to 
view your data? list box. 

10. Select Next >. 

11. Select the desired grouping level from the Do you want to add any 
grouping levels? list box, if applicable. 

12. Select Grouping Options. 

13. Select the Grouping intervals list. 

14. Select the desired interval. 

15. Select OK. 

16. Select Next >. 

17. If you have included a Number data type field, select Summary 
Options. 

18. Select the desired summary options. 

19. Select OK. 

20. When you have finished selecting options from the Report Wizard, 
select Finish. 

 

BASING A REPORT ON A QUERY 

 Discussion 
You can use a query as the basis for a report. The query recordset appears as the 
report data. The report is updated each time it is opened or printed to reflect changes 
made to queried data. 
 

  

 
You can also activate the Report Wizard by double-clicking 
the Create report by using wizard option in the Reports 
object list in the Database window, by selecting the Insert 
menu and the Report command, or by clicking the New 
Object button on the Database toolbar and selecting the 
Report command. 
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 Procedures 

1. Display the Reports object list. 

 2. Select the  New button on the Database window toolbar. 

3. Select Report Wizard. 

4. Select OK. 

5. Select the Tables/Queries list. 

6. Select the query on which you want to base the report. 

7. Add the desired fields to the Selected Fields list box, or add all 
fields. 

8. Select Next >. 

9. Select the desired grouping option from the How do you want to 
view your data? list box. 

10. Select Next >. 

11. Select the desired grouping level from the Do you want to add any 
grouping levels? list box, if applicable. 

12. Select Next >. 

13. Select the 1 field list. 

14. Select the first field by which you want to sort. 

15. Select additional sort fields, if desired.  

16. Select Next >. 

17. Select the desired report layout. 

18. Select the desired report orientation. 

19. Select Next >. 

20. Select the desired report style. 

21. Select Next >. 

22. Type the desired report name in the What title do you want for 
your report? box. 

23. Select Finish. 
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USING AUTOREPORT 

 Discussion 
You can use AutoReport to create a report quickly. AutoReport automatically creates 
a simple columnar or tabular report from the selected table or query without 
displaying any dialog boxes or needing any input. You must, however, first select the 
table or query. All fields in the table or query will appear in the report, and the report 
title will be the same as the table or query name. 
 
AutoReport does not automatically save a report; the first time you close the report, 
Access prompts you to save it. 
 

  

 
The AutoReport Wizard creates the report using the most 
recently used report settings. You can switch to Design view 
to change the formatting of an existing report. 

  

 
You can also activate the AutoReport Wizard by first selecting 
the table or query you want to use, and then selecting the 
Insert menu and the AutoReport command or clicking the 
New Object button on the Database toolbar and selecting the 
AutoReport command. When you use either of these 
methods, the report appears in a standard columnar format, 
with no formatting, headers, or footers. 

  
 

 Procedures 

1. Select the Reports object list. 

2. Select the  New button on the Database window toolbar. 

3. Select the desired AutoReport option. 

4. Select the Choose the table or query where the object’s data 
comes from list. 

5. Select the desired table or query. 

6. Select OK. 
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LESSON 4 -  
USING ADVANCED REPORT DESIGN  

In this lesson, you will learn how to: 

• Add report sections in Design view  

• Create a calculated control  

• Group data in a report  

• Create group headers and footers  

• Create a running summary  

• Insert a date/time control  

• Insert a page break  

• Change the report margins  

• Use the Label Wizard  

• Create a report without using a wizard  
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ADDING REPORT SECTIONS IN DESIGN VIEW 

 Discussion 
You can create or customize a report in Design view. A report has three basic 
sections: Detail, Report Header/Footer, and Page Header/Footer. 
 
The Detail section contains the information from the table or query. You create 
controls in the Detail section that display information. You can display either one 
record per page or multiple records per page. 
 
The Report Header and Report Footer sections display at the top and bottom of the 
report in Design view. When you print the report, these sections appear at the 
beginning and the end of the report only. The header can be used for report titles, 
while the footer can be used for report totals or other summaries. 
 
The Page Header and Page Footer sections display at the top and bottom of the 
report in Design view. When the report is printed, these sections appear at the top and 
bottom of every page. Page headers and footers can contain images, lines, text, or any 
other controls you want printed on every page. 
 
When you enable the display of either header and footer section, both the header and 
the footer appear. You can drag the header and footer sections to size them. 

 
Adding report sections 
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 Procedures 

1. Open the desired report in Design view. 

2. Select the View menu. 

3. Select the Page Header/Footer or Report Header/Footer 
command. 

 

CREATING A CALCULATED CONTROL 

 Discussion 
You can add a calculated control to a form or report. A calculated control is not bound 
to a field. It contains an expression that uses information from fields to calculate a 
result. The result is not stored in a table. It is calculated when the report or form is run. 
 
You can type the expression that calculates the result directly into the control or open 
the property sheet and type the expression into the Control Source property box on 
the Data page. 

 
A calculated control created in a report 
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You can also create an expression using the Expression 
Builder. You can open the Expression Builder by clicking the 
Build button on the Report Design toolbar, selecting 
Expression Builder and then OK. The Expression Builder 
button also appears to the right of the Control Source 
property on the Data page in the property sheet. 

  

 
A calculated control in a form or report cannot be based on 
another calculated control in the form or report. However, you 
can base a calculated control on a calculated field in a query. 

  
 

 Procedures 

1. Open the desired report in Design view. 

2. Display the toolbox. 

3. Click the Text Box tool  in the toolbox. 

4. Click in the desired location for the control. 

5. Type the desired calculated control expression. 

6. Press [Enter]. 

7. Select the label box paired with the control. 

8. Press [Delete]. 

 

GROUPING DATA IN A REPORT 

 Discussion 
You can group data in reports that have a common field. It is often easier to read a 
report when data is grouped, since you can then easily find the pertinent data. For 
example, you can group a sales report by region so that regional personnel can easily 
locate the data for their region. 
 
A grouped report automatically sorts the table by the data in the grouped field. You 
can nest groups inside one another, up to ten levels. For example, in the regional 
report, you may want to group by state within each region. 
 
When you group data, you can display a group header and footer that can be used to 
display information at the top or bottom of each group. For example, you can add a 
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calculated control in a group footer that calculates summary information, such as a 
total or an average for each group. Additionally, you can control page breaks by 
specifying how group heading and records should be kept together. 
 

  

 
You can also use the Sorting and Grouping dialog box to 
specify multiple fields on which to sort. You do not have to 
display group headers or footers for all sort fields. For 
example, you can group an order form by order number and 
sort within the group by order date. 

  
 

 Procedures 

1. Open the desired report in Design view. 

2. Click the Sorting and Grouping button  on the Report Design 
toolbar. 

3. Select the Field/Expression list. 

4. Select the desired field. 

5. Select the corresponding Sort Order field. 

6. Select the Sort Order list. 

7. Select the desired sort order. 

8. Select the Group Header property. 

9. Select the Group Header list. 

10. Select the desired option. 

11. Select the Group Footer property. 

12. Select the Group Footer list. 

13. Select the desired option. 

14. Select the Group On property. 

15. Select the Group On list. 

16. Select the desired option. 

17. Click the Close button. 
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CREATING GROUP HEADERS AND FOOTERS 

 Discussion 
You can create a header and footer for each group that appears in a grouped report. 
 
The header displays at the top of each group. Often, the group header contains the 
control for the grouped field, meaning that the common value on which the grouping 
is based, such as the region, appears only once at the top of each group. 
 
A group footer is often used to display summary information about the group, such as 
total or average sales. You create a group summary by inserting a calculated control 
into the group footer and create an expression using an aggregate function such as 
Sum to display group totals or Avg to display group averages. Group aggregate 
functions can also be placed in a group header. 

 
A group header in a report 

 
  

 
You can also create an expression using the Expression 
Builder. You can open the Expression Builder by clicking the 
Expression Builder button to the right of the Running Sum 
property on the Data page in the property sheet. You can also 
use the Build button on the Report Design toolbar to open the 
Expression Builder. 
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 Procedures 

1. Open the desired report in Design view. 

2. Select the control you want to insert into the group header. 

3. Drag the control to the corresponding group header section. 

4. To create a group summary, click the Text Box tool in the toolbox. 

5. Click in the location for the control. 

6. Type the desired summary expression for the calculated control. 

7. Press [Enter]. 

8. Select the label box paired with the control. 

9. Double-click the text in the label box. 

10. Type the desired label text. 

11. Press [Enter]. 

 

CREATING A RUNNING SUMMARY 

 Discussion 
In a grouped report, you can create a running summary of the items in the group. A 
running summary provides a cumulative total for all the groups above. 
 
Often, the running summary is positioned in the group footer, which appears at the 
bottom of every group. For example, in a sales report grouped by region, you can 
create a calculated field that displays information in a running summary. After each 
group, a cumulative total for all the groups above appears. 
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Using an expression to create a running summary 

 

 Procedures 

1. Open the desired report in Design view. 

2. Create the group summary calculated control expression. 

3. Select the calculated control. 

4. Click the Properties button  on the Report Design toolbar. 

5. Select the Data tab. 

6. Select the Running Sum property. 

7. Select the Running Sum list. 

8. Select the desired option. 

9. Click the Close button to close the property sheet. 

 

INSERTING A DATE/TIME CONTROL 

 Discussion 
You can insert controls that display the current date and/or time in a report. Each 
control updates automatically every time the report is previewed or printed. By 
default, a date/time control is inserted into the Report Header section. However, you 
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can easily move it to another section. For example, you could place the date in the 
Report Footer section so that it would be readily visible on the last page of the report. 
 

  

 
The Date and Time dialog box inserts a control that uses the 
=Date() function to display the current date. 

  

 
If you create a report with the Report Wizard, Access 
automatically inserts a date/time control in the Page Footer 
section with the =Now() function, formatted to show the date 
only in Long Date format. 

  
 

 Procedures 

1. Open the desired report in Design view. 

2. Select the Insert menu. 

3. Select the Date and Time command. 

4. Select or deselect options as desired. 

5. Select OK. 

6. Drag the date control to the desired position in the report. 

 

INSERTING A PAGE BREAK 

 Discussion 
When you print a report, Access automatically starts a new page when necessary. You 
can control the pagination by inserting a page break. You can insert a page break in 
the Group Footer section to place each group on its own page, or you can insert a 
page break in the Report Header section to create a separate title page for a report. 
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Previewing a page break 

 

 Procedures 

1. Open the desired report in Design view. 

2. Display the toolbox. 

3. Click the Page Break tool  in the toolbox. 

4. Click in the location for the page break. 

 

CHANGING THE REPORT MARGINS 

 Discussion 
By default, the margins for a report are one inch on all sides. You can control the 
margin settings to fit more or less data on a page as necessary. The margins you set 
for a report are saved and applied each time you print the report. 
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 Procedures 

1. Open the desired report in Design view. 

2. Select the File menu. 

3. Select the Page Setup command. 

4. Select the text in the Top box. 

5. Type the new measurement for the top margin. 

6. Select the text in the Bottom box. 

7. Type the new measurement for the bottom margin. 

8. Select the text in the Left box. 

9. Type the new measurement for the left margin. 

10. Select the text in the Right box. 

11. Type the new measurement for the right margin. 

12. Select OK. 

 

USING THE LABEL WIZARD 

 Discussion 
Access has a Label Wizard that guides you through the process of creating a report 
that prints labels. You can choose from many standard types of labels, or you can 
create your own custom label definition. 
 
The Label Wizard provides a sample label into which you insert the fields you want to 
print in their desired order. You can also type additional text that you want to appear 
on each label. For example, if you are creating an address label, you may want to 
include the text Attn: before the name of the addressee. 
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Labels created using the Label Wizard 

 

 Procedures 

1. Display the Reports object list in the Database window. 

2. Select the  New button on the Database window toolbar. 

3. Select Label Wizard. 

4. Select the Choose the table or query where the object’s data 
comes from list. 

5. Select the desired table or query. 

6. Select OK. 

7. Select the desired unit of measurement under Unit of Measure. 

8. Select the Filter by manufacturer list. 

9. Select the desired label manufacturers. 

10. Select the desired label type under Product number in the What 
label size would you like? list box. 

11. Select Next. 

12. Select the desired font and color options. 

13. Continue selecting the desired font and color options. 

14. Select Next. 

15. Select the field for the first row from the Available fields list box. 

Organizational & Staff Development, U of T Page 45
 



Lesson 3 - Using Advanced Report Design Access 2002 - Level 3 

16. Press [Enter]. 

17. Continue adding fields from the Available fields list box, as 
appropriate. 

18. Select Next. 

19. Add the field by which you want to sort from the Available fields 
list box. 

20. Select Next. 

21. Type a name for the report. 

22. Select Finish. 

 

CREATING A REPORT WITHOUT USING A WIZARD 

 Discussion 
You can create a report from scratch in Design view. For example, if a report does not 
currently exist for a particular table or query, you can create one using the fields in the 
selected table or query. You can then determine the design of the report by adding 
fields, control, and options. 

 
A report created without using a wizard 
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Access 2002 - Level 3 Lesson 3 - Using Advanced Report Design 

 Procedures 

1. Display the Reports object list. 

2. Select the  New button on the Database window toolbar. 

3. Select Design View. 

4. Select the Choose the table or query where the object’s data 
comes from list. 

5. Select the table or query on which you want to base the report. 

6. Select OK. 

7. Add items to the report as desired. 
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Calculated controls 

creating, 23, 24 
Calculated fields 

creating, 3, 4 
formatting, 4 
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using in a query, 7, 8 
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Date control 
inserting, 28, 29 

Footer 
adding to a report, 22, 23 
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creating, 26, 27 
displaying summary information, 26, 27 

Group headers 
creating, 26, 27 

Grouping 
report data, 24, 25 
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adding to a report, 22, 23 

Label Wizard 
using, 31, 32 

Margins 
changing, 30, 31 

Page breaks 
inserting, 29, 30 

Page Footer, 22 
Page Header, 22 
Parameter queries 

creating, 7 
Print preview, 13, 14 
Printing 

report pages, 15, 16 
Queries 

applying a filter, 8, 9 
basing reports on, 18, 19 
creating a calculated field, 3, 4 
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filtering, 8, 9 
formatting calculated fields, 4 
grouping records, 5, 6 
parameter, 6, 7 
setting top values, 2, 3 
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using a concatenation in, 8 

Report Wizard, 11, 12 
Reports 

adding headers and footers, 22, 23 
AutoReport, 20 
basing on a query, 18, 19 
changing the margins, 30, 31 
columnar, 11 
creating, 11, 12 
creating a calculated control, 23 
creating a group header and footer, 26, 27 
creating a running summary, 27, 28 
creating blank, 33, 34 
creating without a wizard, 33, 34 
grouping and summarizing data, 16, 17 
grouping data, 24, 25 
inserting a date control, 28, 29 
inserting a page break, 29, 30 
inserting a time control, 28, 29 
printing pages, 15, 16 
sections, 22 
tabular, 11 
using in Design view, 22 
using the Label Wizard, 31, 32 
viewing, 13, 14 

Running summary 
creating, 27, 28 

Time control 
inserting, 28, 29 
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USING ACCESS DATA IN A WORD MERGE 

 Discussion 
If you have your names and addresses stored in an Access table, it is possible to use 
them to generate a form letter in Word.  
 
Alternatively, you can use the Merge It with Microsoft Word button on the toolbar.  
 

Procedures 
1. Open the desired Access database. 
2. Click on the table or query you want to use in your merge letter. 
3. Select Tools. 
4. Select Office Links. 
5. Select Merge it with Microsoft Word. 
6. Select from the options – use an existing Word document or create a new one. 
7. Select the desired Document Type.  For our purposes here, select Form Letters. 
8. Click on Next: Starting Document. 
9. Select the Starting Document option: Use the Current Document 
10. Click on Next: Select Recipients to confirm the data source. 
11. Click Next: Write your letter. 
12. If you have not already done so, in the main document, type the text that you want to 

appear in every form letter.  
13. Use one of the following methods to insert merge fields where you want to merge names, 

addresses, and other data from the data source. 

Address Block with Name, 
Address, and Other Information 
a. Click Address block.  
b. In the Insert Address Block dialog box, 

select the address elements you want to 
include and the formats you want. 

c. Click OK.  
d. If the Match Fields dialog box appears, 

Microsoft Word may have been unable 
to find some of the information it needs 
for the address block.  

Click the arrow next to (not available), 
and then select the field from your data 



source that corresponds to the field required for the mail merge.  

Greeting Line 
a. Click Greeting line.  
b. Select the greeting line format, which includes the salutation, name format, 

and following punctuation.  

 
c. Select the text you want to appear in cases where Microsoft Word can't 

interpret the recipient name, for example, when the data source contains no 
first or last name for a recipient, but only a company name.  

d. Click OK.  
e. If the Match Fields dialog box appears, Microsoft Word may have been 

unable to find some of the information it needs for the address block.  

Click the arrow next to (not available), and then select the field from your 
data source that corresponds to the field required for the mail merge.  

Other Fields of Information 

a. Click More items.  
b. Do one of the following:  

• To select from address fields that will automatically map to 
corresponding fields in your data source, even if the data source's fields 
don't have the same name as your fields, click Address Fields.  

• To select from fields that always take data directly from a column in a 
database, click Database Fields.  

• In the Fields box, click the field you want.   

• Click Insert 
• Click Close.  

c. If the Match Fields dialog box appears, Microsoft Word may have been 
unable to find some of the information it needs for the address block.  

Click the arrow next to (not available), and then select the field from your 
data source that corresponds to the field required for the mail merge.  



14. Format the letter in the fashion you would like. To format any of the merged fields, you 
must format in the main document. Formatting in the data source is not retained when 
you merge the data into the document.  

 
• Be sure that you include the surrounding merge field characters («« »») when you 

select the field you want to format. 
 
15. After you've completed the main document and inserted all of the merge fields, save the 

document.  
16. When you have entered all the merge fields, click on Next: Preview Your Letters. 
17. Check that the fields have been properly place.  If you need to make any changes, return 

to the previous step. 
18. To preview the items in order, click the arrow buttons.     
19. To locate and preview a specific 

item, click Find a recipient, and 
then enter the search criteria in the 
Find Entry dialog box.  

 

 
 
 
 
 
20. If necessary, fine-tune the recipient list.  

 
• To exclude a particular recipient from the merge, click Exclude this 

recipient while looking at the recipient’s letter. 
• To change the list of recipients, click Edit recipient list, and then make your 

changes in the Mail Merge Recipients dialog box.  
 
21. Click on Next: Complete the Merge. 
22. Complete the merge by selecting one of the following: 

Personalize Individual Letters 
To personalize individual documents, you actually complete the merge, and then edit the 
information you want in the resulting merged document. 

a. Click Edit individual letters.  
b. In the Merge to New Document dialog box, select the records you want to 

merge. 



c. Click OK. 

Microsoft Word creates and opens a new merged document. Your main 
document also remains open, and you can switch back to it if you want to 
make a change to all the documents.  

d. Scroll to the information you want to edit, and make your changes. 
e. Print or save the document just as you would any regular document. 

Print the Letters 
Do one of the following: 
If you personalized the items and the merged document is active 

1. Select File … Print.  
2. Select the options you want. 
3. Click on OK. 

If you want to print directly from the Mail Merge Wizard 
1. Click Print.  
2. In the Merge to Printer dialog box, select one of the following: 

 Click All to print all the documents. 
 Click Current record to print the document that you see in the 

document window.  
 Click From, and type in the record numbers in the From and To 

boxes to print a range of documents. 
3. Click on OK. 
4. In the Print dialog box, select the options you want.  

Save the Merged Letters for Later Use 
If you want to edit merged letters or save them for later use, you can collect them 
into a single document. 
1. Click Edit individual letters.  
2. In the Merge to a New Document dialog box, do one of the following,  

 Click All to print all the documents. 
 Click Current record to print the document that you see in the 

document window.  
 Click From, and type in the record numbers in the From and To 

boxes to print a range of documents. 
3. Click on OK. 
 
Microsoft Word opens a single new document that contains all the individual 
letters. You can then save the document for later use, just as you would any 
regular document.  

 
 



USING ACCESS DATA TO CREATE A WORKSHEET 

 Discussion 
You may want to create a worksheet in an existing Excel workbook using Access 
data. You can easily send a table or query from the source file in Access to the 
destination file in Excel. The exported data appears automatically on the last 
worksheet in the workbook and the tab reflects the name of the Access table and 
query. Once the data is exported to Excel, it becomes part of the destination file and 
can only be edited using Excel features.  
 
When you export Access data to Excel, the destination file to which you are exporting 
needs to be closed or you cannot export the data. Once the data is exported, you can 
open the destination file in Excel to view and edit the Access information. 

Procedures 

1. Close the Excel file to which you want to send the Access data. 

2. Open Access. 

3. Open the Access database containing the desired data. 

4. Select the Tables or Queries tab. 

5. Click on the desired table or query. 

6. Select the File menu. 

7. Select the Export command. 

8. Select the Save as type list and change to Microsoft Excel 97-2002 
(*.xls). 

9. Locate the desired Excel file to which you want to send the table or 
query.  

10. Click on Export. 

 

USING ACCESS DATA TO CREATE A WORKBOOK 

 Discussion 
You may have Access data you want to use to create a new Excel workbook. Rather 
than copy and paste the information, you can send it to Excel to create a new 
workbook. Once the data is sent to Excel, you can edit it using features of the source 
application, just as you would edit a workbook created in Excel. 

 



   
• You can also access the Analyze It with MS Excel command 

from the OfficeLinks submenu on the Tools menu. 
 

   

Procedures 

1. Open the desired Access database. 

2. Select the Table or Queries tab.  

3. Select the desired data. 

4. Click the arrow on the OfficeLinks button.   

5. Select the Analyze It with MS Excel command. 

 
 
 
 



JOIN TYPES IN A QUERY 
When you add more than one table or query to a query, you need to make sure their field 
lists are joined to each other with a join line so that Microsoft Access knows how to 
connect the information.   An association between a field in one table or query and a field 
of the same data type in another table or query is defined as a JOIN.  A join tells 
Microsoft Access how data in each of the tables or queries is related to the other tables or 
queries. 

If you previously created relationships between tables in the Relationships window, 
Access automatically displays join lines when you add related tables in query Design 
view. If referential integrity is enforced, Access also displays a "1" above the join line to 
show which table is on the "one" side of a one-to-many relationship and an infinity 
symbol (∞) to show which table is on the "many" side. 

If relationships were not previously defined and if one of the fields is a primary key, 
Access automatically creates a join between fields with the same names and data types.  
The chances are good that this will be the correct join but you should always check.  
There will not be a “1” or infinity sign displayed when this happens. 

If the tables you add to the query don't include any fields that can be joined, you will 
need to add one or more extra tables or queries to serve as a link between the tables with 
the data you need.  For example, with the Graduate Student database, you would need to 
add the Student_Faculty table to be able to select a list of graduate student names with 
their supervisor names. 

 

If you add tables to a query and there no join lines appear, the resulting dataset will 
include every permutation of records between the two tables as Access doesn't know 
which records in the first table are associated with which records in the second table. If 
one table had 50 records in it and the other had 10, the query's results will contain 50x10  
or 500 records. These queries usually take a long time to run and do not produce 
meaningful results. 



You can also create joins manually.  There are three Join Types to choose from. 
 
 
Join Type Description 
Inner Join 
(Default) 
 
 
 

A join in which records from two tables are combined and added 
to a dataset only if the values of the joined fields match and meet 
any conditions specified. 
 
Example:  When looking for student addresses, the only records 
which would be displayed would be records where there was a 
matching student number in the both tables.  You would not see 
students who did not take courses, nor would you see courses for 
which there was no current student. 
 

 
 
If there are records in the Master table for which there are no 
detail records OR if there are records in the Detail table for which 
there is no record in the Master table, those records will not 
appear in the resulting dataset. 
 

Outer Join With an outer join, Access retrieves records from one of the tables 
whether a matching record is found in the other table or not. 
 

Left Outer Join 
 
 

 

A left outer join includes all of the records from the first (left) of 
two tables, even if there are no matching values for records in the 
second (right) table. A left outer join is indicated by a join line 
arrow pointing from left to right. 
 
Example: When looking for addresses, all records would be 
displayed from the Student table (on the left) whether or not there 
was a matching record in the Student Addr table (on the right). 
You would not see courses for which there was no current 
student. 
 



 
 
Records from the table on the right will only be included if there 
is a match in the joined field.  Therefore, there may be some 
records in the table on the right which are not displayed. 
 

Right Outer Join 
 

 
    

A right outer join includes all of the records from the second 
(right) of two tables, even if there are no matching values for 
records in the first (left) table. A right outer join is indicated by a 
join line arrow pointing from right to left. 
 
Example: When looking for addresses, all records would be 
displayed from the Student Addr table (on the right) whether or 
not there was a matching records in the Student table (on the left). 
You would not see students for which there was no matching 
student number in the Student Addr table. 
 



 
 
Records from the table on the left will only be included if there is 
a match in the joined field.  Therefore, there may be some records 
in the Student table which are not displayed. 
 

 

DEFINE JOIN TYPES 
 
Defining the join type for a relationship in the Relationships window doesn't affect the 
relationship itself; it sets the kind of join that will be used by default when creating 
queries based on the related tables. You can always override the default join type later 
when defining a query. By default, Microsoft Access creates an inner join between 
related tables. 
 
1. Create the relational joins that you need between the tables by dragging the common 

field or fields from one table to another. Just as when you define relationships, you 
are connecting the primary key of one table (the field(s) shown in bold in the Table 
Lists) to a field of another table in the query.    

 
If the join lines are overlapping or crossing tables, you should just reposition the 
tables by dragging them to a better location in the window. 

 
2. In the Query-By-Example screen, double-click on the line joining the field lists of the 

tables in the query. 
 
3. Click the desired join type. 

Option 1 defines an inner join. This is the default. 
Option 2 defines a left outer join. 
Option 3 defines a right outer join. 



 

 
 
4. Click on OK. 
 

DELETING JOINS AND TABLES 
If Access adds a join which you don’t want, you can delete the join.   
 
1. Click on the join line to select it – the line will appear bolded. 
 
2. Press Delete.    
 
Once the join is removed, you can remove the tables from the QBE grid as well.  Click 
anywhere in the table’s Field List and press Delete. 
 
 



 

SETTING QUERY PROPERTIES 
Each query has property settings that you can change to alter the way the query behaves and how the query 
results look. 
 

 
 
To display the Query Properties dialog box shown above, you can do one of the following: 

• Select View … Properties from the menu bar in the Query window 
• Point at the top half of the query window and select Properties from the shortcut menu 
• Click in the top half of the query window and click on the Properties button on the toolbar 
• Double-click in the top half of the query window 
 
You can also set properties for the individual fields in the query.  Slightly different options are available for 
fields.  To see the Properties dialog box for a field, click in the field you want and use the shortcut menu. 
 

 Description 
This works best with fields, rather than the general query.  In the Description property, type the description 
you want the status bar to display for that field in the query's results. Users will see the new description in 
the status bar when they click in the field in query Datasheet view. 
 

 Output All Fields 
Use to show all fields in the query's underlying data. This is an easy way to show all fields in the query 
while only moving those you are setting criteria for or sorting on down to the query grid. 
 

Yes Displays all the fields in the underlying tables and in the field list of a form or report. 
No (Default) Displays only fields having the Show box selected in the query design grid. 

 



 Top Values 
Use to return a specified number of records or percentage of records that meet the criteria specified. For 
example, you might want to return the bottom 5 values or the top 10% of values in a field. 
 
Use together with sorted fields. The field you want to display top values for should be the leftmost field 
that has the Sort box clicked in the query design grid. An Ascending sort returns the bottommost records, 
and a Descending sort returns the topmost records. If you specify that a specific number of records be 
returned, all records with values that match the value in the last record are also returned. 
 

 Unique Values 
Use when you want to omit records that contain duplicate data in the fields displayed in Datasheet view. 
For example, if a query's output includes more than one field, the combination of values from all fields 
must be unique for a given record to be included in the results.  This property uses all the fields which 
have been moved to the query grid. 
 
Yes Displays only the records in which the values of all fields displayed in Datasheet view are 

unique. 
No (Default) Displays all records. 
 

 Unique Records 
Use to specify whether to return only unique records based on all fields in the underlying data source, not 
just those fields present in the query itself. 
 

Yes (Default) Doesn't return duplicate records. 
No Returns duplicate records 

 
 Run Permissions 

Used in a multi-user environment with a secure workgroup to override the existing user permissions.  
 

Owner's All users are allowed the owner's permissions to view or run the query. 
User's (Default) Users have only their own permissions to view or run the query. 

 
 

 Records Locks 
Use to set what happens when two users try to edit the same record at the same time. When you edit a 
record, Microsoft Access can automatically lock that record to prevent other users from changing it before 
you are finished. You can use this property to specify whether records in a query (typically an action query 
in a multi-user database) are locked while the query is run. 
 

No Locks (Default) In queries, records aren't locked while the query is run. 

All Records All records in the underlying table or query are locked while the query is run. 
Although users can read the records, no one can edit, add, or delete any records 
until the query has finished running. 

Edited Record 
(Forms and queries 
only) 

A page of records is locked as soon as any user starts editing any field in the 
record and stays locked until the user moves to another record. Consequently, a 
record can be edited by only one person at a time. This is also called 
"pessimistic" locking. 

 

SET PROPERTIES FOR A QUERY, ITS FIELDS, OR ITS 
FIELD LISTS 
You can set properties for queries, field lists in a query, and fields you add to the design grid in a query. 



 
1. In query Design view, select the field, field list, or query. 

 To select a field, click the cell in the Field row. 
 To select a field list, click anywhere in the list. 
 To select the whole query, click anywhere in query Design view outside the design grid and 

the field lists. 
2. Click on the toolbar to display the property sheet for the selected object. 
3. In the property sheet, click the property you want to set, and then do one of the following: 

 If an arrow appears in the property box, click the arrow and then click a value from the list. 
 Type a setting or expression in the property box. 

4. If a Build button appears next to the property box, click it to display a builder. 
5. If you need more space to enter or edit a property setting, press SHIFT+F2 to open the Zoom box. 
 
Tip: When you click a property in the property sheet, a short description of the property appears in the 

status bar. For more information on the property and its settings, click the property and then press 
F1. 


